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HP Connectivity Kit

Introduction
HP Connectivity Kit is software that facilitates the creation 
and distribution of HP Prime content and establishes a 
classroom network of HP Prime calculators. The 
classroom network can then be used to broadcast the 
content you create. HP Prime content includes HP apps 
and their data, exam-mode configurations, formative 
assessments (polls), notes, and even messages to 
individual students. Poll responses can be aggregated 
and the results displayed for discussion purposes. You 
can monitor the network of HP Prime calculators and 
project a student display for discussion purposes. 

You can use Connectivity Kit in any of the following 
modes:

• connected from a computer running Connectivity Kit 
to one or more HP Prime calculators, using the USB 
cable included in the product package

• connected wirelessly to one or more HP Prime 
calculators using the HP Prime Wireless Kit 
(purchased separately) to form an HP Wireless 
Classroom Network

• connected to one or more virtual calculators on the 
same computer (HP Prime Virtual Calculator is a 
program that is available separately)

Whichever mode you choose, Connectivity Kit allows you 
to create and edit custom HP Prime content to extend and 
customize your HP Prime calculator. In addition, the HP 
Wireless Classroom Network provides features that 
enhance the HP Prime classroom experience.

Connectivity Kit provides the following capabilities:

• manage content and data on one or more connected 
calculators

• prepare custom HP Prime content
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• send HP Prime content to one, some, or all connected 
calculators 

• receive poll results from connected calculators and 
analyze the results

• send a message to one, some, or all connected 
calculators

• receive a message from a connected calculator

• activate and deactivate exam mode on connected 
calculators

• monitor and capture calculator activity

• project one student display live to the class for the 
purposes of classroom discussion 

• update calculator software

• back up and restore your calculator

• clone one HP Prime calculator to another

For detailed information about the functionality of the HP 
Prime calculator, see the HP Prime Graphing Calculator 
User Guide.

Getting started

Naming a 
calculator

Before installing Connectivity Kit, make sure that the 
calculators you plan to use with Connectivity Kit have 
been named. This will enable you to distinguish one 
connected calculator from another in the Connectivity Kit 
window.

To name a calculator, follow the steps below.

1. On the calculator, press SH (Settings). The 
Home Settings screen opens.

2. Tap  to go to the second page of the 
screen.

3. Tap the Calculator Name box.

4. Use the calculator keys to enter the calculator name in 
the box.

5. Tap .
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Installing 
Connectivity Kit

Whether you plan to use Connectivity Kit with a single HP 
Prime calculator connected via the USB cable or with an 
entire class connected wirelessly, you must first install 
Connectivity Kit. On the included product CD, locate the 
file HP_Connectivity_Kit.exe, and double-click it. Or, on 
the HP website, locate the file HP_Connectivity_Kit.exe, 
download it to your computer, and then double-click it. 
Follow the on-screen instructions to complete the 
installation.

Starting 
Connectivity Kit

If you installed the Connectivity Kit icon on your desktop, 
locate and double-click the icon to start Connectivity Kit. 

Otherwise, follow the steps below:

1. On the computer, open the Start menu.

2. Locate and open the HP Calculators folder.

3. Click HP Connectivity Kit.

Elements of the 
interface

When the software opens, Connectivity Kit presents three 
panes, as well as the familiar title, menu, and icon bars 
at the top of the window. These three permanent panes 
are as follows:

• The calculator pane at the top left

• The content pane at the bottom left

• The work area on the right
menu baricon bar

content pane work area

calculator pane
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The calculator pane When a calculator is connected, its name appears in the 
calculator pane. Click the expand arrow beside a 
calculator name to expand the list of content for the 
calculator. Double-click an object in the list to open an 
editor in the work area. 

The content pane The HP Prime content that is stored on your computer 
appears in the content pane, in folders dedicated to each 
type of content, such as exam-mode configurations and 
polls. As in the calculator pane, you can double-click a 
content item to open its editor in the work area.

The work area The work area has two purposes. First, it is the area 
where the content editors appear. Second, it is the control 
center for the HP Wireless Classroom Network, where the 
Monitor and Messages windows appear. 

The menu bar The menu bar contains four menus: File, Edit, Windows, 
and Help. Each of these four menus is described in detail 
in the following sections. 

The File menu The File menu lists the following options:

• Language: display a menu to choose a language for 
the application

• Exit: close the application

The Edit menu The Edit menu lists the following options:

• Cut: cut the selected data from the editor and place it 
in the clipboard

• Copy: copy the selected data from the editor and 
place it in the clipboard

• Paste: paste the clipboard contents at the cursor 
location

• Preferences: open a dialog box that lists the following 
options:

• Working folder: the default folder for the HP 
Prime calculator on your computer, as shown in 
the content pane

• Wireless options: choose either a channel or 
Automatic Selection, and then choose an SSID 
name for your wireless network
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The Windows menu The Windows menu lists the following options:

• Close: close the active editor

• Close All: close all editors

• Tile: tile the editors

• Cascade: cascade open editors

• Next: move to the next editor

• Previous: move to the previous editor

• Messages: open the Messages window in the work 
area

• Monitor: open the Monitor window in the work area

The Help menu The Help menu lists the following options:

• HP Connectivity Kit User Guide: open this document

• Go to HP.com: open the HP website

• Check for Update: check for updates for the software

• About HP Connectivity Kit: get information about the 
version of the software

The icon bar The icon bar contains shortcuts for some of the most 
frequently used options in the menu bar. There are two 
icons on the left for content and two on the far right for 
the work area, as explained in the following sections.

Save icon If you are working in the calculator pane, clicking the Save 
icon saves the data in the active editor to the connected 
calculator.

If you are working in the content pane, clicking the Save 
icon saves the content in the active editor to your 
computer rather than to a calculator. Specifically, the 
content is saved to the working directory specified under 
Preferences in the Edit menu.

Save All icon You might have multiple editors open in the work area, 
some with HP Prime content on your computer (from the 
content pane) and others with HP Prime content on your 
calculator (from the calculator pane). Clicking the Save 
All icon saves all of your work, in its current state, on the 
appropriate devices. If you close the application without 
saving your work, you will be prompted to Save All 
before closing.
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Monitor icon Click the Monitor icon to open the Monitor window in the 
work area. This is a shortcut for opening the Monitor 
window via the Windows menu.

Messages icon Click the Messages icon to open the Messages window 
in the work area. This is a shortcut for opening the 
Messages window via the Windows menu.

The classroom 
network ID

You connect the computer running Connectivity Kit to 
multiple calculators by either connecting the USB cable 
included with each HP Prime calculator to a USB port on 
the computer or to a USB hub or using wireless adapters 
(purchased separately). When a number of calculators 
are connected wirelessly in a classroom setting, give your 
network a unique ID to distinguish it from other wireless 
networks in the vicinity.

1. In the Connectivity Kit menu bar, click Edit and select 
Preferences. The Preferences dialog opens.

2. In the SSID box, enter a unique classroom ID, such as 
Ms_May_Math_Period1.

3. Click OK.

Connecting a 
calculator via 
USB

To connect an HP Prime calculator to the computer 
running Connectivity Kit, use the USB cable included in 
the product package, and follow the steps below. It is best 
if your computer has an active Internet connection.

1. Start Connectivity Kit, if you have not done so already 
(see “Starting Connectivity Kit”).

2. The cable included in the HP Prime package has two 
connectors. Connect the micro-USB end to the micro-
USB port on the top of the HP Prime calculator and 
then connect the standard USB plug to a USB port on 
your computer. 

3. Turn on the HP Prime calculator. The HP Prime 
calculator will appear by name in the calculator 
pane; if it does not, try using a different USB port on 
your computer.

4. If the software of your HP Prime calculator cannot 
connect to Connectivity Kit, you will be prompted to 
update the software. Accept the software update, and 
the calculator will first update and then connect.
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Connecting a 
calculator 
wirelessly

To connect an HP Prime calculator to the computer 
running Connectivity Kit, by using the HP Prime Wireless 
Kit (purchased separately), follow these steps:

1. Connect the antenna included with the HP Prime 
Wireless Kit to a USB port on your computer.

2. Start Connectivity Kit (see “Starting Connectivity Kit”).

3. Connect the wireless module to the micro-USB port on 
the top of the calculator.

4. Turn on the HP Prime calculator.

5. Tap the date/time in the upper right corner of the HP 
Prime display. A window opens, displaying the 
wireless status icon. 

6. Tap this icon to connect to the classroom network. A 
menu opens. Click the list arrow to display the 
available networks, and then click the name of your 
network.

Connecting to 
the virtual 
calculator

If you start HP Prime Virtual Calculator on the same 
computer that is running Connectivity Kit, the virtual 
calculator connects automatically to Connectivity Kit.

Whichever method you use to connect, the HP Prime 
calculator will appear by name in the calculator pane, 
with an expansion arrow that you can click to see the 
contents of the HP Prime calculator. 

Establishing an HP Wireless Classroom Network
This section describes how to establish an HP Wireless 
Classroom Network and provides details for 
troubleshooting wireless connections. If you plan to use 
Connectivity Kit with the USB cable only, you can skip this 
section.

About the 
wireless 
network

Connectivity Kit establishes your wireless classroom 
network using the following items:

• the antenna provided in the HP Prime Wireless Kit

• the wireless module for the HP Prime calculator

• an SSID name to identify the network to an HP Prime 
calculator

• a channel for sending and receiving signals



8 HP Connectivity Kit

Connectivity Kit establishes the wireless network to 
identify itself to the available HP Prime calculators. By 
default, a Connectivity Kit network uses the name 
HP_Classroom_Network as its SSID. You will want to 
change this name to something more unique so that two 
nearby networks do not have the same name, and so that 
your students can identify the correct network if more than 
one is available (see “Changing the SSID”). By default, 
Connectivity Kit chooses a channel for you. You can 
manually change the channel if it encounters interference 
from other networks in the area.

Troubleshooting 
a wireless 
connection

If you follow the steps for a wireless connection (see 
“Connecting a calculator wirelessly”) and do not see the 
HP Prime calculator appear by name in the calculator 
pane, follow these steps:

1. Confirm that the calculator is on.

2. Verify that the wireless USB adapter is properly 
plugged in to the calculator.

3. On the HP Prime calculator, go to the fourth page of 
the Home Settings screen and verify that the 
calculator is connected to the correct wireless 
network. The network name in the top box of the 
Page 4 Home Settings must match the SSID name in 
Connectivity Kit. If it does not, tap the top box on the 
HP Prime calculator to open the drop-down box and 
select the correct network by name.

Changing the 
SSID

To confirm, edit, or change the SSID of the classroom 
network on Connectivity Kit, follow these steps:

1. On the Connectivity Kit menu bar, click Edit and 
select Preferences.

2. In the Preferences dialog box, locate the SSID box 
near the bottom of the box. The name in that box is 
the current name of your wireless classroom network.

3. To change the name, click the SSID box, delete the 
current name, and enter your own unique name for 
the network.

4. Tap the OK button when you are done.
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Selecting a 
channel 
manually

By default, Connectivity Kit selects one of 13 channels 
automatically for its wireless classroom network. If you 
encounter interference with a nearby network, you can 
change the channel used for your wireless network to 
eliminate that interference. Use the following procedure.

1. Confirm that you have given your wireless network a 
unique ID (see “Changing the SSID”).

2. If your network ID is unique and you are still seeing 
calculators that are not in your network, try selecting 
a different channel for your wireless network. Return 
to the Preferences dialog box, clear the check box 
next to Automatic Selection, and then select a 
different channel using the up and down arrows to 
the right of the Channel box. Tap OK to exit the 
Preferences dialog box.

3. You might need to repeat Step 2 until you find a 
channel that does not interfere with nearby networks.

4. You might have to restart Connectivity Kit.

The calculator pane

Introduction Once you have connected an HP Prime calculator to 
Connectivity Kit, you can customize and extend your HP 
Prime calculator with data, programs, notes, apps, and 
so on by using the calculator pane. From the calculator 
pane in Connectivity Kit, you can do the following:

• view and edit Home settings

• back up, restore, and clone your HP Prime calculator

• view the contents of the calculator 

• drag and drop HP Prime content from the calculator 
pane to the content pane

• drag and drop HP Prime content from your computer 
to a calculator in the calculator pane

• open editors in the work area

The calculator 
context-sensitive 
menu

After the HP Prime calculator appears by name in the 
calculator pane, right-click the name of the HP Prime 
calculator to open its context-sensitive menu. The 
following options are available:
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• Preferences: edit many of the setting on the first two 
pages of the calculator’s Home settings

• Rename: change the name of the calculator (from 
Page 2 of the Home settings)

• Get screen capture: copy or save the current display 
of the calculator

• Backup: Back up the calculator to your computer

• Restore: restore the calculator from a backup file you 
saved to your computer

• Clone from here: clone this calculator to another 
calculator

• Refresh: refresh the display of this calculator to 
Connectivity Kit

• Properties: see the version date and number of the 
calculator software

• Update firmware: update the calculator software to 
the latest version available

Using the 
calculator pane

Click the expand arrow to the left of the name of an HP 
Prime calculator to expand the list of content types on the 
calculator. The list will show the Application Library, 
Complex number variables, Exam Configurations, and so 
on. Some of the names in the list have expand arrows and 
others do not. Those with expand arrows are categories 
of content; for example, Application Library. Click an 
expand arrow to see the list of content in that category. 
Click a content item to select it. You can drag it to another 
calculator in the calculator pane to copy that item to the 
calculator. You can also drag it to the content pane to 
copy it to your computer. If you have HP Prime content on 
your desktop, you can drag it to a calculator in the 
calculator pane to copy it to that calculator; if the file has 
multiple types of HP Prime content (apps, programs, 
notes, and so on), the different content objects will be 
sorted and saved to the appropriate locations. You can 
drag HP Prime content from your desktop to the content 
pane. You can also drag content from the content pane 
to a calculator in the calculator pane to copy the item to 
that calculator. You can right-click an item or category to 
open the context-sensitive menu for that content type or 
category. The menus vary slightly among the content 
types. 
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You can drag a calculator name from the calculator pane 
to your desktop. A folder with that name will appear on 
your desktop, containing all of that calculator’s settings 
and data.

The editors Each HP Prime content type has its own dedicated editor. 
See “The editors and the work area” for more details on 
using the editors to create and edit the various HP Prime 
content types.

The content pane

Introduction The content pane is where you keep the HP Prime content 
on your computer. The content pane displays the contents 
of the working folder, as listed in Preferences in the Edit 
menu. Within this folder are all the HP Prime content files 
you have saved to your computer, along with additional 
folders for exam-mode configurations, polls, and poll 
results. As in the calculator pane, you can perform the 
following tasks in the content pane:

• view the HP Prime content that is stored on your 
computer

• drag and drop HP Prime content from the content 
pane to a calculator in the calculator pane

• drag and drop HP Prime content from your computer 
to Connectivity Kit

• open editors in the work area for HP Prime content

Unlike the calculator pane, the content pane allows you 
to perform the following additional tasks:

• create and edit class polls

• view and project poll results

• broadcast a poll

• broadcast poll results

When broadcasting polls, poll results, or HP Prime 
content, you can choose to broadcast to the entire class, 
a single group within the class, or a single HP Prime 
calculator.

It is important to keep in mind that the content pane 
contains the HP Prime data and content that is stored on 
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your computer, while the calculator pane shows many of 
the same types of content stored on an HP Prime 
calculator. In both panes, when you double-click an 
object, the object will open in its own editor in the work 
area. See “The editors and the work area” for more 
details on each editor.

The editors and the work area

Introduction The work area contains all open editors for HP Prime 
content. It also contains the Monitor and Messages 
windows when you have those windows open.

The editors Each HP Prime content type (note, program, app, and so 
on) has its own special editor, designed to make it easy 
for you to create and edit custom content to customize 
and extend your HP Prime calculator. The following 
sections describe each editor in turn.

Note: The following sections assume that you are opening 
the editors from the calculator pane. However, the 
behavior is the same if you open an editor from the 
content pane. The only difference is where the HP Prime 
content is stored. 

When you save from an editor in the calculator pane, the 
content is stored on an HP Prime graphing calculator or a 
virtual calculator. When you save from an editor that you 
opened from the content pane, the content is stored to 
your computer in the default working folders in the 
content pane.

Renaming a 
calculator

You can use Connectivity Kit to give your HP Prime 
calculator a name or change its name.

1. In the calculator pane, locate the name of the calculator 
you want to rename.

2. Right-click the calculator name, and select Rename.

3. Type the new calculator name, and press the Enter 
key.

To confirm that the connected calculator has been 
renamed, press SH (Settings), and tap 

 to move to the second page of the Home 
Settings screen. You will see the new calculator name in 
the Calculator Name box.
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Editing Home 
settings

You can use Connectivity Kit to edit Home settings on 
your HP Prime calculator. For detailed information about 
the Home settings in the HP Prime calculator, see the HP 
Prime Graphing Calculator User Guide.

To edit the Home settings on your HP Prime calculator:

1. In the calculator pane, locate the name of the 
calculator whose settings you want to edit.

2. Right-click the calculator name, and select 
Preferences. The Preferences dialog box opens.

3. Edit the settings.

4. Click Save.

To confirm that the settings have been edited in the 
connected calculator, press SH (Settings) to open 
the Home Settings screen. You will see the edited settings 
in the pages of the screen.

Backing up data 
and settings

You can use Connectivity Kit to back up the data and 
settings of a connected calculator:

1. In the calculator pane, locate the name of the calculator 
whose data and settings you want to back up. Click the 
expand arrow next to the calculator’s name.

2. Right-click the calculator name, and select Backup. A 
Backup dialog box opens.

3. Navigate to the location in which you want to save 
the backup zip file.

4. Give the backup zip file an appropriate file name.

5. Click Save.

Restoring data 
and settings

You can use Connectivity Kit to restore the data and 
settings of your HP Prime calculator from a backup zip file 
saved to your computer.

1. In the calculator pane, locate the name of the 
calculator that you want to restore. Click the expand 
arrow next to the calculator’s name.

2. Right-click the calculator name, and select Restore. A 
Restore dialog box opens.

3. Navigate to the location in which you saved the 
backup zip file you now want to restore.

4. Click the backup zip file.
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5. Click Open.

After you click Open, the name of the calculator whose 
data and settings you are restoring will disappear 
momentarily from the list of calculator names in the 
calculator pane. When the data and settings have been 
successfully restored, the name of the calculator will re-
appear at the end of the list of calculator names.

Cloning a 
calculator

You can use Connectivity Kit to clone data and settings of 
one HP Prime calculator and apply them to another HP 
Prime calculator:

1. In the calculator pane, locate the name of the calculator 
whose data and settings you want to clone. Click the 
expand arrow next to the names of these calculators.

2. Right-click the calculator name, and select Clone from 
here.

3. Locate the name of the calculator to which you want 
to apply the cloned data and settings.

4. Right-click the calculator name, and select Clone to 
here.

After you select Clone to here, the name of the calculator 
to which you are applying the cloned data and settings 
will disappear momentarily from the list of calculator 
names in the calculator pane. When the data and settings 
have been successfully cloned, the name of the calculator 
will re-appear at the end of the list of calculator names.

Editing real 
variables

You can use Connectivity Kit to edit real variables (A–Z 
and ) on your HP Prime calculator.

The real variable editor in Connectivity Kit has two 
columns. The left column contains the variable names, 
and the right column contains the values assigned to the 
variables. By default, each complex variable is assigned 
a value of 0. To edit real variables:

1. In the calculator pane, locate the name of the 
calculator whose real variables you want to edit.

2. Click the expand arrow beside the calculator name to 
expand the list of content for the calculator.

3. In the expanded list, double-click Real. The Real 
variable editor opens in the editor pane.

θ
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4. In the editor, click the cell to the right of the name of 
the variable you want to edit.

5. Use the computer keyboard to enter the desired value 
for the variable in the cell, and press Enter. The 
highlight cursor moves to the next variable in the 
editor.

6. Repeat steps 4 through 5 for any other real variables 
you want to edit.

7. Click the Save icon in the icon bar.

To confirm that the new value of a variable has been 
saved to your connected HP Prime calculator, go to the 
Prime Home view, press the key combination that 
corresponds to the variable you edited, and press 
E. You will see the new value of the variable in the 
history. For example, if you set the real variable B to be 
32, when you press ADE, you will see 32 in 
the history.

Editing complex 
variables

You can use Connectivity Kit to edit the complex variables 
Z1–Z9 and Z0.

The complex variable editor in Connectivity Kit has two 
columns. The left column contains the variable names. The 
right column contains the values assigned to the 
variables. If a variable has no value assigned to it, a 0 
appears in the right column beside that variable name. 

Complex variables can be entered in the editor as either 
(x,y) or x+yi (where x is the real part of the complex 
number, and y is the imaginary part).

To edit complex variables on your HP Prime calculator:

1. In the calculator pane, locate the name of the 
calculator whose complex variables you want to edit.

2. Click the expand arrow beside the calculator name to 
expand the list of content for the calculator.

3. In the expanded list, double-click Complex. The 
complex variable editor opens in the editor pane.

4. In the editor, click the cell to the right of name of the 
variable you want to edit.

5. Use the computer keyboard to enter the desired value 
for the variable in the cell, and press Enter. The 
highlight cursor moves to the next variable in the 
editor.
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6. Repeat steps 4 through 5 for any other complex 
variables you want to edit.

7. Click the Save icon in the icon bar.

To confirm that a variable has been edited in the 
connected calculator, go to the Home view, press the key 
combination that corresponds to the variable you edited, 
and press E. You will see the edited value of the 
variable in the history. For example, if you set complex 
variable Z0 to be 5+3*i, when you press 
AyNE, you will see 5+3*i in the 
history.

Editing list 
variables

You can use Connectivity Kit to edit the list variables 
L1–L9 and L0.

The list variable editor in Connectivity Kit has a row at the 
top that contains the variable names. The subsequent 
rows contain the values assigned to the variables. If a list 
variable has no values assigned to it, the rows below that 
variable name are blank.

To edit a list variable:

1. In the calculator pane, locate the name of the 
calculator whose list variables you want to edit.

2. Click the expand arrow beside the calculator name to 
expand the list of content for the calculator.

3. In the expanded list, double-click List. The list variable 
editor opens in the editor pane.

4. In the editor, click the cell below the name of the 
variable you want to edit.

5. Use the computer keyboard to enter the first element 
of the list into the cell, and press Enter. The highlight 
cursor moves to the next element in the list.

6. Use the computer keyboard to enter the second 
element of the list into the cell, and press Enter.

7. Repeat steps 5 through 6 for the other elements in the 
list, and repeat steps 4 through 6 for any other list 
variable you wish to edit.

8. Click the Save icon in the icon bar.

To confirm that a list has been saved to your HP Prime 
calculator, go to the Home view, press the key 
combination that corresponds to the list you edited and 
press E. You will see the edited value of the 
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variable in the history. For example, if you set list variable 
L1 to be {1,2,3,4,5}, when you press 
AjxE, you will see {1, 2, 3, 4, 5} in the 
history.

Editing matrix 
variables

You can use Connectivity Kit to edit the matrix variables 
M1–M9 and M0.

You can edit only one matrix variable at a time in the 
matrix variable editor. The number of rows and columns 
in the editor depends on the number of rows and columns 
in the matrix variable you are editing. When you edit 
data in the final column or row, the editor creates a new 
column or row in case you need it.

To edit a matrix variable:

1. In the calculator pane, locate the name of the 
calculator whose matrix variable you want to edit.

2. Click the expand arrow beside the calculator name to 
expand the list of content for the calculator.

3. In the expanded list, click the expand arrow beside 
Matrices to expand a list of the names of matrix 
variables.

4. In the second expanded list, double-click the name of 
the matrix variable you want to edit. A matrix 
variable editor opens in the editor pane.

5. Click the top left cell.

6. Use the computer keyboard to enter the desired value 
into the cell, and press Enter.

7. Move to another cell in the editor by either clicking 
the cell or pressing the arrow keys on the computer 
keyboard.

8. Use the computer keyboard to enter the desired value 
into this cell, and press Enter.

9. Repeat steps 7 through 8 for the other elements in the 
matrix.

10.Click the Save icon in the icon bar.

To confirm that a matrix has been saved to your HP Prime 
calculator, go to the Home view, press the key 
combination that corresponds to the variable you edited 
and press E. You will see the edited value of the 
variable in the history. For example, if you set matrix 
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variable M1 to be [[1,2],[3,4]], when you press 
AQx, you will see [[1, 2], [3, 4]].

Editing and 
creating 
programs

You can use Connectivity Kit to edit and create programs 
for your HP Prime calculator. For detailed information 
about programming, see the programming chapter of the 
HP Prime Graphing Calculator User Guide.

To edit a user program on your HP Prime calculator:

1. In the calculator pane, locate the name of the 
calculator whose user program you want to edit.

2. Click the expand arrow beside the calculator name to 
expand the list of content for the calculator.

3. In the expanded list, click the expand arrow beside 
Programs to expand a list of names of user programs. 
(If there is no expand arrow beside Programs, the 
calculator has no user programs.)

4. In the second expanded list, double-click the name of 
the user program you want to edit. A program editor 
opens in the editor pane.

5. Use the computer keyboard to edit the program in the 
editor.

6. Click the Save icon in the icon bar.
To confirm that the program has been saved to your HP 
Prime calculator, press Sx to open the Program 
Catalog. You will see the program name in the catalog. 
Tap the name, and you will see the edited and saved 
program.

To create a user program:

1. In the calculator pane, locate the name of the 
calculator in which you want to create the new user 
program.

2. Click the expand arrow beside the calculator name to 
expand the list of content for the calculator.

3. In the expanded list, right-click Programs and select 
New.

4. An edit box appears. Enter a name for your new 
program and press the Enter key. The program editor 
opens with your new program.

5. Use the computer keyboard to enter the program in 
the editor.

6. Click the Save icon in the icon bar.
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To confirm that the program has been created on your HP 
Prime calculator, press Sx to open the Program 
Catalog. You will see the program name in the catalog. 
Tap the name, and you will see the edited and saved 
program. 

Editing and 
creating notes

You can use Connectivity Kit to edit and create notes for 
your HP Prime calculator.

To edit a note on your HP Prime calculator:

1. In the calculator pane, locate the name of the 
calculator whose note you want to edit.

2. Click the expand arrow beside the calculator name to 
expand the list of content for the calculator.

3. In the expanded list, click the expand arrow beside 
Notes to expand a list of names of notes. (If there is 
no expand arrow beside Notes, the calculator has no 
notes.)

4. In the second expanded list, double-click the name of 
the note you want to edit. A note editor opens in the 
editor pane.

5. Use the computer keyboard to edit the note in the 
editor.

6. Click the Save icon in the icon bar.

To confirm that the edited note has been saved to your HP 
Prime calculator, press SN to open the Note 
Catalog. You will see the note name in the catalog. Tap 
the name and you will see the edited note. 

To create a note and save it to your HP Prime calculator, 
follow these steps:

1. In the calculator pane, locate the name of the 
calculator in which you want to create the note.

2. Click the expand arrow beside the calculator name to 
expand the list of content for the calculator.

3. In the expanded list, right-click Notes and select New.

4. An edit box appears. Enter a name for your new note 
and press the Enter key. The note editor opens with 
your new note.

5. Use the computer keyboard to add the note text in the 
editor.

6. Click the Save icon in the icon bar.
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To confirm that the note has been created on your HP 
Prime calculator, press SN to open the Note 
Catalog. You will see the name of the note in the catalog. 
Tap the note name to see the note text.

Editing app 
content

You can use Connectivity Kit to edit the data in any HP 
app and then save it to your HP Prime calculator. In this 
manner, you can create examples and send them to your 
HP Prime calculator, and then connect your HP Prime 
calculator to another HP Prime calculator and send that 
app along.

The data in an HP app are contained in app variables. 
Each app also has its own program and its own note. 
Each app editor in Connectivity Kit has tabs for the 
different types of app content that you can edit. All app 
editors have Modes, Program, and Info (Note) tabs. App 
editors may also have some or all of the following tabs: 
Results, Symbolic, Plot, and Numeric. 

For example, the Function app editor has a Symbolic tab 
with the variables F1(X), F2(X), etc. The Plot tab has Xmin, 
Xmax, and the other variables associated with the Plot 
view. You edit these variables to set up the app with the 
functions you want and the Plot view settings, etc. Then 
you save the whole app to your HP Prime calculator.

For detailed information about the app objects for each 
app, see the HP Prime Graphing Calculator User Guide.

To edit app content on your HP Prime calculator:

1. In the calculator pane, locate the name of the 
calculator whose app content you want to edit.

2. Click the expand arrow beside the calculator name to 
expand the list of content for the calculator.

3. In the expanded list, click the expand arrow beside 
Application Library to expand the list of app icons.

4. In the second expanded list, double-click the icon of 
the app whose content you want to edit. The app 
editor opens in the editor pane.

5. In the app editor, click the tab that contains the app 
object you want to edit. 

6. Edit the object as required.

7. If you want to edit another app object, click the tab 
that contains it.
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8. Edit the object as required.

9. Repeat steps 7 through 8 for any other app objects 
you want to edit.

10.Click the Save icon in the icon bar.

To confirm that the HP app has been saved to your HP 
Prime calculator, press I, tap the icon of the app 
whose content you edited. Go to each view of the app to 
see the content you edited. If you edited the Info note, 
press SI to see it; if you edited the app program, 
press Sx to open the Program Catalog, and then 
open the app program to see your changes.

Exam-mode 
configurations

The functions and features of the HP Prime calculator can 
be temporarily restricted for examination purposes. The 
process of restricting one or more HP Prime calculators for 
an examination is referred to as exam-mode 
configuration.

Exam-mode configuration can be done on one HP Prime 
calculator and then started on that HP Prime calculator or 
sent to another HP Prime calculator. Or you can use 
Connectivity Kit to define, start, and stop an exam-mode 
configuration.

Using Connectivity Kit, you can define one or more exam-
mode configurations, start a configuration on an 
connected HP Prime calculator, start the same exam-mode 
configuration on all wirelessly connected HP Prime 
calculators, and stop an exam-mode configuration on one 
or more connected HP Prime calculators.

The exam-mode configuration editor in Connectivity Kit 
lets you set the following parameters:

• the time after which the exam mode will time out

• the default angle format (or none)

• a password to deactivate the exam mode

• whether the calculator memory is erased when the 
exam mode is activated

• whether the 3 LED lights on the calculator blink while 
it is in exam mode. 

After setting these options as you prefer, you then select 
the functions and features you wish to disable while the 
calculator is in exam mode. For detailed information 
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about exam-mode configurations, see the HP Prime 
Graphing Calculator User Guide.

To edit an exam-mode configuration on your HP Prime 
calculator:

1. In the calculator pane, locate the name of the 
calculator whose exam-mode configuration you want 
to edit.

2. Click the expand arrow beside the calculator name to 
expand the list of content for the calculator.

3. In the expanded list, click the expand arrow beside 
Exam Configurations to expand the list of names of 
exam-mode configurations.

4. In the second expanded list, double-click the name of 
the configuration you want to edit. The exam-mode 
configuration editor opens in the editor pane.

5. Select the features you want to disable during the 
examination. Click an expand arrow to expand the 
list of features that you can disable. 

6. Click the Save icon in the icon bar.

To confirm that the exam-mode configuration has been 
edited in the connected calculator, press SH 
(Settings), and tap  twice to move to the 
third page of the Home Settings screen. In the 
Configuration drop-down list, select the name of the 
configuration. You will see the edited configuration 
settings on this page, and if you tap  you will see 
the functions you selected to disable.

To create a new exam-mode configuration for your HP 
Prime calculator:

1. In the calculator pane, locate the name of the 
calculator for which you want to create a new exam-
mode configuration.

2. Click the expand arrow beside the calculator name to 
expand the list of content for the calculator.

3. In the expanded list, click the expand arrow beside 
Exam Configurations to expand the list of names of 
exam-mode configurations.

4. In the second expanded list, right-click Default Exam, 
and select Copy.

5. A new exam mode named Default Exam Copy 
appears. Right-click Default Exam Copy, select 
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Rename, and then enter a name for your new exam-
mode configuration.

6. Double-click the name of the new configuration. An 
exam-mode configuration editor opens in the editor 
pane.

7. Select the features you want to disable during the 
examination. Click an expand arrow to expand the 
list of features that you can disable. 

8. Click the Save icon in the icon bar.

To confirm that the exam-mode configuration has been 
created on your HP Prime calculator, press SH 
(Settings), and tap  twice to move to the 
third page of the Home Settings screen. In the 
Configuration drop-down list, select the name of the exam-
mode configuration. You will see the edited configuration 
settings on this page, and if you tap  you will see 
the functions you selected to disable.

Deleting, 
resetting, and 
clearing HP 
Prime content 
objects

HP Prime content objects have rules regarding deletion. 
For example, an HP app that you have saved with a new 
name can be deleted from the App Library, but a native 
HP app can only be reset to factory defaults and cannot 
be deleted entirely. Similarly, the Home variables can be 
cleared of their current contents but cannot be deleted 
entirely. Conversely, notes and programs can be deleted 
from memory. There must always be at least one exam-
mode configuration. This configuration can be reset, and 
any additional exam-mode configurations can be 
deleted. To delete, reset, or clear an HP Prime content 
object, right-click it and select the appropriate option 
(clear, reset, or delete) from the menu. Pressing the delete 
key on your computer keyboard does not delete HP Prime 
content.

Updating the HP Prime software
You can use Connectivity Kit to update the software of an 
HP Prime calculator. Updating software will ensure that 
the calculator has any new features included in the latest 
version. 

To update calculator software, the calculator must be 
connected with a cable to the computer on which 
Connectivity Kit is running. Calculator software cannot be 
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updated if the calculator is connected to the computer via 
a wireless network. 

Updating calculator software does not result in loss of 
current data and settings of the calculator, but it is 
recommended that you save a backup of the data and 
settings just in case. Refer to “Backing up data and 
settings” on page 13 for details of how to do this.

Downloading 
new software

You must check periodically to see if updated software 
has been released. To check for an update, your 
computer must have an active Internet connection. To 
check to see if there is an update to your existing 
software, follow these steps:

1. Connect the HP Prime calculator to your computer 
using the included USB charging cable.

2. Start HP Connectivity Kit.

3. In the Calculators pane, right-click the name of the HP 
Prime calculator you wish to update and select 
Properties.

4. Make a note of the version number and then click the 
OK button.

5. Click the Help menu and select Check for update.

6. The Check for update pop-up box appears. You will 
see various messages as Connectivity Kit looks for an 
update. If it finds one, it will ask if you wish to 
download it.

7. If the version number is later than the version number 
you noted in step 5, click the Download button; 
otherwise click the Cancel button.

Updating the 
software

To update the HP Prime software, follow these steps:

1. Connect the HP Prime calculator to your computer 
using the included USB charging cable.

2. Start HP Connectivity Kit.

3. Click the Calculators pane.
4. In the Calculators pane, right-click the name of the HP 

Prime calculator you wish to update and select 
Update firmware.

5. The Update firmware pop-up box will appear in the 
calculator tab and the calculator display will change 
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to Recovery Mode. You will see various messages as 
the software files are updated on your HP Prime 
calculator. After the software has been successfully 
updated, the HP Prime calculator will reset itself and 
you will be able to use it and access any new 
features.

Troubleshooting 
a software 
update

If for any reason the software does not update 
successfully, try the following steps:

1. Reset the HP Prime calculator by inserting the end of 
a paper clip into the reset hole in the back of the 
calculator.

2. Connect the USB cable to a different USB port on 
your computer.

3. Repeat steps 2 through 5 in “Updating the software”.

The HP Wireless Classroom Network
HP Connectivity Kit can be used with up to 30 HP Prime 
calculators and the HP Prime Wireless Kit (purchased 
separately) to create the HP Wireless Classroom 
Network. The HP Wireless Classroom Network allows a 
teacher to use Connectivity Kit as follows:

• Monitor and capture the students’ HP Prime displays

• Project one student’s HP Prime display for discussion 
purposes

• Broadcast HP content to the class

• Start and stop exam-mode configurations for the 
entire class

• Display poll results for discussion purposes and send 
poll results back to the class

In addition, students can use the HP Prime message center 
to respond to a poll, send the teacher a message, or raise 
a quick flag for help. All of these features are explained 
in the following sections.

Preparing class content
From the content pane in Connectivity Kit, you can 
prepare HP Prime content for classroom distribution, 
including the following:
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• Home variables (lists, matrices, etc.)

• HP apps with their data

• Notes and programs

• Exam-mode configurations

• Formative assessments (polls and quizzes)

• Poll or quiz results

The content created here is saved to your computer in the 
working folder you specify in the Preferences dialog box 
in the Edit menu.

You edit HP Prime content in the content pane exactly the 
same way as in the calculator pane (see “The calculator 
pane”). The focus in these sections is on creating exam-
mode configurations and polls for distribution to a class.

Preparing 
exam-mode 
configurations

The functions and features of the HP Prime calculator can 
be temporarily restricted for examination purposes. The 
process of restricting one or more HP Prime calculators for 
an examination is referred to as exam-mode 
configuration.

Creating and editing exam-mode configurations can be 
done in the content pane, and the configuration can be 
saved to your computer. You can select a configuration 
and then start or stop the configuration for the whole 
class.

The exam-mode configuration editor in the content pane 
of Connectivity Kit lets you set the following:

• a name for your configuration 

• the time after which the exam mode will time out

• the default angle format (or none)

• a password to deactivate the exam mode

• whether the calculator memory is erased when the 
exam mode is activated

• whether the three LED lights on the calculator blink 
while it is in exam mode. 

After setting these options as you prefer, you then select 
the functions and features you wish to disable while the 
calculator is in exam mode. You can disable any or all of 
the following:
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• HP apps

• Saved apps

• Physics constants

• The Help system

• Units

• Matrices

• Complex number operations

• The CAS

• Connectivity (I/O)

• Notes and Programs

• New Notes and Programs

• The Math menu

For the HP apps, you can disable all of them or just a 
selection, as you see fit. Select the System Apps check box 
to disable all HP apps or click the expand arrow beside 
it to expand the list of HP apps. Select the app you want 
to disable. For each app, you can also disable one or 
more of its app functions. Click the app’s expand arrow 
to see the list of app functions. 

For the Math menu, you can disable an entire category of 
functions (for example, Probability) or just a single 
function or command (for example, Combinations). Click 
the expand arrow next to Mathematics to expand the list 
of categories to get started.

When you are finished, save the configuration. You can 
then start and stop the configuration for the whole class 
using the exam-mode editor of Connectivity Kit.

To edit and save an exam-mode configuration:

1. Click the expand arrow beside the Exam Modes 
folder to expand the list of names of exam-mode 
configurations.

2. If you want to edit an existing configuration, double-
click the name of the configuration and proceed to 
step 5.

3. To create a new configuration, right-click an existing 
configuration, and then select Copy. A copy will 
appear with a default name. Type in a name for the 
new configuration, and then press Enter.

4. Double-click the name of the new configuration.
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5. Use the computer keyboard and the mouse to create 
or edit the configuration in the exam-mode 
configuration editor.

6. Click the Save icon in the icon bar.

Preparing a 
class poll

You can use Connectivity Kit to create a poll or quiz and 
save it to your computer for later distribution to the class. 
Or you can create a quick 1- or 2-question poll to inform 
instructional decisions or enhance class discussion.

Connectivity Kit has a dedicated editor for creating and 
editing polls. The poll editor in the content pane allows 
you to do the following:

• Name your poll

• Give your poll a descriptive title

• Enter general instructions for the entire poll

• Choose the number of questions in the poll (select up 
to 10 questions)

• Select a type for each question and create or edit 
each question

• Save the poll

The poll editor has the following boxes to help you create 
a poll:

• Title: enter an optional title for your poll

• Instructions: enter an optional set of instructions for 
the entire poll

• Questions: choose 1 to 10 questions for your poll 
(each question appears in its own tab)

• Immediate popup: select this box if you want the poll 
to pop up automatically when it reaches the student’s 
HP Prime calculator, or clear it if you prefer the poll to 
be accessed by pressing Z and selecting the poll 
by name

• Can only send once: select this box if you want the 
student to respond only once to the poll, or clear it if 
you want students to be able to update their 
responses after they are first sent in
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Each question tab has the following boxes:

• Question: enter the question stem here

• Can go back: select this box if you want the student to 
be able to go back to this question after moving to 
the next question, or clear it if you do not want the 
students to return to this question after answering it 
and moving on

• Type: select an option to set the question’s response 
type. You can choose among the following response 
types:

• Multiple choice

• Numerical value

• Point

• Mathematical expression

• Text

If you select a response type other than multiple choice, 
the question is complete at this point. If you select a 
multiple choice response type, you will see the second 
row of options, as shown in the previous figure. Specify 
the particular response set by clicking an option in this 
second row. You can choose among the following types 
of multiple-choice response sets:

• ABCDE: A set of 2 to 5 response blanks which you fill 
in

• Yes/No: Yes or No are the only two responses

• True/False: True or False are the two responses

• Likert Scale (3)

• Likert Scale (5)

If you select a Yes/No or True/False response set, the 
Answer boxes are auto-populated with the relevant 
options, and the question is complete at this point. If you 
select an ABCDE response set, enter the responses into 
the Answer boxes, beginning with the first two (A and B). 
If you select one of the Likert Scale options, you will see 
a third set of radio buttons from which to choose your 
response set:

• Agreement: level of agreement with the question’s 
statement 
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• Confidence: level of confidence

• Occurrence: always, sometimes, or never true 
questions

• Custom: Likert Scale response set created by you

To prepare a poll or quiz in the content pane:

1. To create a new poll, right-click the Poll folder in the 
content pane, and then select New. 

2. The poll folder list expands, and the name box for 
your new poll opens with a default name that you can 
edit. Delete the default name and enter your own, or 
press the Enter key to accept the default name.

3. Double-click the name of the poll you wish to edit to 
open it in the poll editor.

4. Use the computer keyboard and the mouse to edit the 
poll or quiz in the poll/quiz editor.

5. Click the Save icon in the icon bar.

You can return to edit the poll at any time by clicking the 
expand arrow in the Poll folder and then double-clicking 
the name of the poll.
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The Monitor window

Introduction The Monitor window is designed for classroom use. 
Open this window to see thumbnail images of the 
displays of all HP Prime calculators connected to 
Connectivity Kit. The thumbnail images refresh 
periodically so that you can quickly monitor what your 
students are doing with their HP Prime calculators. You 
can use the Monitor window to accomplish the following 
classroom tasks:

• monitor student progress

• capture and save a student display

• project a single student’s display for discussion 
purposes

• distribute HP Prime content

• distribute a poll and collect results

• display and project poll results for discussion 
purposes

• distribute poll results as lists

• start and stop an exam-mode configuration for testing 
purposes

Monitoring the 
class

To monitor the activity of all connected calculators, click 
the Windows menu and select Monitor, or click the 
Monitor icon on the right side of the icon bar. The Monitor 
window will open, showing the screens of all connected 
calculators. To refresh the screens, right-click in the editor 
pane and select Refresh. To automatically refresh the 
student displays every few seconds, right-click in the 
Monitor window and select Automatic Refresh. You can 
deselect automatic refresh using the same steps.

To adjust the size of the calculator thumbnail images, 
right-click in the Monitor window and select Image Size. 
A sub-menu opens from which you can choose small, 
medium, or large.
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Capturing a 
student’s 
calculator 
display

You can capture and save the display of a student’s 
calculator from the Monitor window. Right-click the 
thumbnail of the image you want to save, and then select 
Save As. A Save As dialog box opens. Navigate to where 
you want to save the image, give it an appropriate name, 
select the file type (.bmp, .png, or .jpg), and then click 
Save.

To copy the image the clipboard, right-click the thumbnail 
and select Copy to Clipboard. You can now paste the 
image into a document.

Projecting a 
student’s 
calculator 
display

Any thumbnail of an HP Prime display can be selected for 
projection via a digital classroom projector. Right-click 
the thumbnail, and then select Project. The student’s 
display will appear in its own window. You can right-click 
in the Project window to select a size for the projected 
image, or you can perform a click-and-drag operation on 
the bottom-right corner to resize the Project window. The 
projected image updates quickly so that the student can 
operate their calculator and the class can follow in real 
time. While a student’s calculator display is being 
projected, the rest of the thumbnail images are frozen 
and will not update until the Project window is closed.

Distributing HP 
Prime content

The Monitor window can be used to send HP Prime 
content to one or more student HP Prime calculators in the 
class. To broadcast content to your class, follow these 
steps:

1. In the content pane, click the expand arrow beside 
the folder containing the specific content item you 
want to broadcast.

2. After you see the specific content item you want to 
broadcast (a poll, an HP app, an exam-mode 
configuration, and so on), drag it into the Monitor 
window.

Note: You can also right-click the item, and then select 
Send from the menu.

The content is sent immediately to each HP Prime 
calculator in the HP Classroom Network. If you wish to 
send content to only one HP Prime calculator, first select 
the thumbnail of that calculator in the Monitor window, 
and then follow the previous procedure. To send content 
to a group of HP Prime calculators, press and hold the Ctrl 



HP Connectivity Kit 33

key on your computer keyboard while you select the 
calculators in the group. Then, follow the previous 
procedure.

Accessing HP 
Prime content

After content is sent to one or more student HP Prime 
calculators, the students can access that content. If the 
content is a list, matrix, note, or program, the students can 
access it by going to the proper catalog or library. For 
example, if you send them a new HP app, they can find 
it by pressing I to go to their App library.

Taking a poll on 
an HP Prime 
calculator

What happens with poll content items depends on 
whether the Immediate Popup box was selected when 
creating the poll. If Immediate Popup was selected, the 
HP Prime calculator displays the poll by opening the 
Message Center. If Immediate Popup was not selected, 
the student receives no notification when a poll has been 
delivered. Instead, the student must access the poll by 
pressing Z to open the menu, and then selecting the 
poll by its title from the list. The poll will then open in the 
Message Center.

After the Message Center opens with a poll, the student 
navigates and responds to the poll using the touch menu 
buttons at the bottom of the HP Prime display. The touch 
menu buttons available for use in a poll are as follows:

• : Opens an edit line for entering a value or 
calculation as a response to a question

• : Selects or clears a check mark for an option 
in a multiple choice question

• : Sends the poll responses to Connectivity Kit

• : Navigates from page to page in the 
poll

The exact appearance of the last double menu button 
depends on how many questions the poll contains as well 
as whether the Can go back option for the current 
question was selected when the poll was written.

The student can leave the poll to use the calculator and 
then return to answer the question. For example, the 
student can press H to go to the Home view and make 
a calculation. Then, the student can press Z and select 
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the poll by title from the list to return and answer the 
question.

The student can view a poll after it has been submitted by 
pressing Z to open the menu, and selecting the poll by 
its title. If the Can only send once option was selected 
when the poll was created, the students cannot edit their 
responses and resubmit them after the poll has been 
submitted the first time.

The calculator can store only one poll at a time. When a 
new poll is received from Connectivity Kit, the previous 
one is deleted.

Receiving 
responses and 
analyzing 
results

As the students respond to a poll, you can view the 
aggregated responses. When a poll is created and 
saved, a Results object with the same name is created in 
the Results folder in the content pane. To view the current 
state of the results of your poll, open the Results folder in 
the content pane and then double-click the name of your 
poll. The Results window for your poll opens. 

The Results window will have one tab for each question 
in the poll. The representations on each tab vary 
depending on the response type.

Depending on the response type, you might be able to 
choose from a range of different graphical 
representations. There is a drop-down box at the bottom 
right of the question tab that allows you to select an 
appropriate graphical representation of the aggregated 
poll results for that question. Each tab also has a table of 
all student responses to the question. 

Note that a student’s response will only be included in the 
aggregation if they have submitted it. Note also that if 
you are viewing the results for a question, the results will 
automatically update as more students submit their 
responses to the question.

You can use poll results to make instructional decisions 
during a lesson or you can project the results to the class 
to enhance classroom discussion.

Sending results 
to the class

Just as you can broadcast HP Prime content to the class, 
you can also return poll results to the class. Each poll 
creates a version of the Statistics 1Var app with the same 
name as the poll. The results for each question are stored 
in the Numeric view lists of the app, with the results of 
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Question #1 in D1, the results of Question #2 in D2, and 
so on. To send the poll results back to the students, click 
the Send to class button.

Start and stop 
exam mode

An exam-mode configuration allows you to temporarily 
disable features and commands on your students’ HP 
Prime calculators for testing purposes. You can use 
Connectivity Kit to start or stop an exam-mode 
configuration on one or more HP Prime calculators. For 
information on how to create or edit an exam-mode 
configuration, see “Preparing exam-mode 
configurations”.

To start an existing exam-mode configuration for your 
class, follow these steps:

1. Open the Monitor window.

2. In the content pane, click the expand arrow beside 
the Exam Configurations folder to open it.

3. Double-click the specific exam-mode configuration 
you wish to use.

4. The exam-mode configuration editor will open with 
your selected exam-mode configuration. Take a 
moment to verify that the time duration, password, 
and option to blink LED lights are set correctly.

5. Click the Start button in the editor.

If you chose Blink LED in the configuration, all the HP 
Prime calculators in your class will have the same set of 
LED lights on at the same time. The configuration will 
change every 5 to 10 seconds but will always be 
identical for the same exam-mode configuration. The 
students will see the title bar in their display change from 
blue to orange to indicate to them that an exam-mode 
configuration is active.

To stop exam mode, click the Stop button in the editor or 
tell the students the password to enter on the third page 
of Home Settings.

Send an exam-
mode 
configuration

You can send an exam-mode configuration to a set of HP 
Prime calculators without activating it. It can be activated 
later on each calculator. 

To send an exam-mode configuration without activating 
it, select the exam-mode configuration from the content 
pane and then follow the instructions in “Distributing HP 
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Prime content”. 

You can also send an exam-mode configuration from one 
calculator to another. Select the exam-mode 
configuration on one calculator and drag it to the other 
calculator.

In either case, the exam-mode configuration can then be 
activated on the HP Prime calculator by going to the third 
page of Home Settings and tapping Start.

The Messages window

Introduction The Messages window is also designed for classroom 
use. Open this window to send a message to one student, 
a group of students, or the entire class. Students can reply 
to your message individually or send you a message of 
their own. In addition, a student can raise a flag for help. 
Note that a student cannot send a message to another 
student or receive a message from another student.

Sending 
messages

To send a message, follow these steps:

1. Open both the Monitor window and the Messages 
window.

2. Select recipients for your message in the Monitor 
window.

If you wish to send a message to the entire class, be sure 
that none of the thumbnail images is selected in the 
Monitor window. If you wish to send a message to a 
single HP Prime calculator, click its thumbnail image in 
the Monitor window to select it; you can add more HP 
Prime calculators by holding down the Ctrl key on your 
computer keyboard as you click additional thumbnail 
images.

3. Enter your message in the entry box at the bottom of 
the Messages window.

4. Click the Send to class button when your message is 
complete.

The HP Prime 
Message Center

On the student’s HP Prime calculator, the message 
appears in the Message Center. When you send a 
message to the students, the Message Center will open 
automatically and display your message to the student. A 
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student can always open the Message Center manually 
by pressing Z and selecting Messages.

The Message Center has three menu buttons:

• Reply: The student can tap this button to open an edit 
line to enter a reply. The student will see Cancel and 
Send buttons. They can tap Send to send their reply to 
you.

• Help: The student can tap this button to raise a help 
flag next to their HP Prime calculator name on your 
computer.

• OK: The student can tap this button to exit the 
Message Center.

Sending a reply 
or message 
from an HP 
Prime calculator

A student can reply to your message following these 
steps:

1. In the Message Center, they tap Reply.

2. Then, they press A A to lock alpha mode on and 
enter their message.

3. They tap Send to send their message or Cancel to 
return to the Message Center without sending their 
message.

The student’s message will appear in the Message 
window history, labeled with their HP Prime calculator 
name. A student can send you an unsolicited message by 
pressing Z and selecting Messages, and then following 
the previous procedure.

Sending a quick 
message

You can send a quick message without using the 
Messages window. The steps are as follows:

1. In the Monitor window, select the thumbnail images 
of the HP Prime calculators to which you want to send 
the message.

2. Right-click one of those thumbnail images and select 
Send Message.

3. A Message box will appear. Enter your message in 
the entry line and tap the Send button.

With this method, your message will not appear in the 
Messages window history.
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Raising and 
clearing help 
flags

A student can send a request for help from a calculator 
connected to Connectivity Kit by pressing Z, selecting 
Messages, and then tapping the Help menu button. When 
a student asks for help, a flag appears beside the 
thumbnail image of their calculator in the Monitor 
window. The help flag appears as a question mark in a 
blue circle at the top left of the thumbnail image.

You can clear the flag by right-clicking the thumbnail 
image and selecting Reset Help. If you wish to reset 
multiple student help flags, hold down the Ctrl key on your 
computer keyboard while you select each student. After 
you have selected all the students you want, right-click 
one of their thumbnail images and select Reset Help.


